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Do czego służy ScopeDome Arduino Driver 

ScopeDome Arduino Driver to program dla systemu Windows pozwalający kontrolować i 

automatyzować działanie obserwatoriów astronomicznych sterowanych przy pomocy kart 

ScopeDome Arduino.  

Jego główne funkcje to: sterowanie obrotami kopuły, otwieranie i zamykanie klap, synchronizacja 

pozycji kopuły i teleskopu. Ponadto umożliwia on automatyczne zamykanie klapy kopuły w 

przypadku różnych sytuacji awaryjnych np. zanik zasilania, opady deszczu czy utrata połączenia z 

Internetem.  

Driver wraz z kartą ScopeDome Arduino umożliwia sterowanie pracą różnych typów 

obserwatoriów od RollOffRoof, przez typowe kopuły z jedną lub dwiema klapami po kopuły typu 

Clamshell. Realizowane jest to poprzez odpowiednie zaprogramowanie karty sterującej i wybranie 

właściwych ustawień w programie. Do sterowania kopułą Clamshell i obserwatorium typu 

RollOffRoof wystarczy jedna karta sterująca. Aby kontrolować kopuły astronomiczne z napędami 

obrotu i okna  kopuły niezbędne są dwie karty. Pierwsza z nich steruje obrotami kopuły, druga 

poprzez połączenie radiowe steruje ruchem okna kopuły. 

Driver pozwala również na sterowanie ogrzewaniem silników kopuły, obudów w których mieści 

się elektronika sterująca obserwatorium, dwóch luster teleskopu (lub innych elementów 

wymagających ogrzewania) oraz czujnika deszczu i chmur.  

Driver może łączyć się z popularnymi stacjami pogodowymi, kamerą AllSky, czujnikiem chmur i 

deszczu, miernikiem jakości nieba SQM i odczytywać z nich dane. 

Notacja używana w instrukcji 

Program posiada bardzo wiele opcji konfiguracji. Aby odwołać się do wywołania konkretnej opcji 

lub elementu w  instrukcji będziemy używać notacji: Window>Tab>GroupBox>Element Name 

Przykładowo: Main>Dome State> Dome Radar to odwołanie do elementu Dome Radar w 

głównym oknie programu. 

 

Zasada działania programu 

Po uruchomieniu program łączy się z kartą i zaczyna cyklicznie odczytywać jej stan. Z poziomu 

interfejsu użytkownika w programie, platformy ASCOM, lub wewnętrznych procedur drivera 

przesyłane są do karty rozkazy np. obrotu do zadanej pozycji, otworzenia klapy czy włączenia 

przekaźnika. Wszystkie rozkazy są asynchronicznie umieszczane w kolejce a następnie jeden po 

drugim przesyłane do karty, która je wykonuje. Naciśnięcie przycisku „STOP” zatrzymuje 

wykonanie ostatniego rozkazu i czyści całą kolejkę. 

Należy pamiętać o tym, że karta i driver działają niezależnie i asynchronicznie – co może 

prowadzić do niezrozumiałego na pierwszy rzut oka zachowania oprogramowania lub kopuły. 

Driver może również wykonywać rozkazy działające cyklicznie na przykład: włączone opcje „Sync 

with Scope” czy „Sync with Wind”, cały czas ustawiają (synchronizują) pozycję kopuły w zależności 

od aktualnej pozycji teleskopu lub kierunku wiatru. Włączenie „Sync With Sky” spowoduje, że 

kopuła wykona jeden obrót na 24h. 

Karta i driver mogą niezależnie od siebie i automatycznie zamykać klapę w sytuacjach awaryjnych. 

Możemy skonfigurować kartę tak, że jeśli uaktywni się wejście ”Cloud Sensor”, „Rain Sensor”, „No 

Power” lub „Low UPS Battery”  klapa obserwatorium zamknie się automatycznie. Należy 

pamiętać, że stanie się to nawet wtedy, gdy komputer sterujący obserwatorium jest wyłączony. 
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Dodatkowo gdy na komputerze sterującym uruchomiony jest driver można automatycznie 

zamykać klapę: po utracie połączenia z Internetem, w przypadku złej pogody, o zadanej godzinie 

lub gdy klapa jest zbyt długo otwarta. 

 

Uwaga: Ze względu na to, że karta zamyka klapę bez udziału komputera, w oknie drivera nie 

zostanie wyświetlony rozkaz jej zamknięcia. Klapa po prostu się zamknie.  

Można również podać warunki niezbędne do otworzenia lub zamknięcia klapy takie jak: 

zaparkowanie teleskopu z poziomu ASCOM, aktywne wejście zaparkowania teleskopu na karcie, 

brak deszczu, chmur lub dobry stan pogody. Może to być przydatne w sytuacji sterowania 

obserwatorium przy pomocy takich programów jak CCD Commander czy ACP. 

Warunek logiczny „Weather>Weather Condition Info>Good Weather” obliczany jest następująco: 

Not (Cloud OR Cloudy OR Rain OR (Wind Speed>Hi Wind Speed)). Zatem jeśli którekolwiek z tych 

wejść będzie aktywne to warunek Good Weather nie będzie spełniony, co w efekcie nie pozwoli 

na otwarcie kopuły. 

 

Niezależnie od wywoływanych funkcji  driver lub karta obsługują termostaty pozwalające na 

utrzymanie stałej temperatury silników, obudów elektroniki, czy odraszanie czujnika chmur i 

deszczu. Zapisuje też niezbędne informacje w plikach, statystyki czujnika chmur, oraz zdjęcia z 

kamery AllSky, jeśli jest skonfigurowana w systemie. 

Jeśli zmieniasz cokolwiek w konfiguracji programu pamiętaj o zapisaniu tych zmian i restarcie 

drivera. Jeśli zmiany mogą dotyczyć konfiguracji karty pamiętaj o wysłaniu ich do karty 

przyciskiem „Card>Send config to Card”.  

 

Uwaga: Nigdy nie zmieniaj więcej niż jednego parametru na raz. Zwykle prowadzi to do 

kłopotów z działaniem oprogramowania. Zmień jeden parametr i przetestuj, co dały te zmiany. 

Jeśli wszystko działa tak jak się spodziewałeś zapisz je, jeśli nie jesteś pewien nowych ustawień 

wróć do starych ładując ostatnią zapisaną konfiguracje karty. Jeśli zupełnie się pogubiłeś zacznij 

od domyślnych ustawień karty uruchamiając przyciśnij przycisk „Restore Default”. 
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Zabezpieczenia wbudowane w driver 

Driver ma wbudowane zabezpieczenia przed nieprawidłowym działaniem enkodera pozycji kopuły 

i wyłączników krańcowych nadzorujących działanie klapy.  

Driver nie pozwala na przekroczenie licznika enkodera pozycji kopuły określonej w 

„Config>Card>Card Configuration>Encoder Max Value/ Encoder Min Value”. Jeśli kolejna 

operacja obrotu kopuły będzie powodować przekroczenie maksymalnej lub minimalnej wartości 

licznika enkodera nie zostanie ona wykonana lub kopuła zacznie obracać się w przeciwną stronę, 

aby  – wykona ruch analogiczny do Telescope Flip. 

Jeśli z powodu bezwładności masy kopuły licznik jednak zostanie przekroczony – driver pozwoli 

jedynie na ruch w przeciwną stronę (zmniejszający wartość licznika enkodera). 

Cały czas będzie działało ręczne sterowanie kopuły (z przycisków na panelu karty) w kierunkach 

CW lub CCW. Obracanie kopuły w kierunku poza zakres licznika enkodera będzie wyłączone 

Jeśli przekroczono zakres enkodera – najprostszym i najszybszym wyjściem jest ręczne 

naprowadzenie kopuły na sensor Home i zresetowanie licznika enkodera kopuły za pomocą 

przycisku  Config>Card>Dome Counters and encoder calib.> Reset Encoder ENC = 0.  

 

Można też cofnąć licznik enkodera „Main>Dome commands>GoTo” wybierając z rozwijanej listy 

opcję Derotate, która zacznie obracać kopułę w kierunku wartości enkodera równej 0. 

Driver zawsze sprawdza, czy enkoder pozycji kopuły działa prawidłowo. W tym celu mierzy, czy w 

zadanym czasie wartość licznika zmieniła się o wybraną liczbę impulsów. Decydują o tym 

parametry:  

a) Config>Dome>Dome Rotate>Min counterd delta  

b) Config>Dome> Dome Rotate>Time to check.  

 
Dla standardowych ustawień podczas obrotów kopuły w ciągu 5 sekund enkoder musi zmienić 

wartość o 1. Jeśli tego nie zrobi silnik kopuły zostanie zatrzymany i zostanie zgłoszony błąd 

działania programu z komunikatem „Dome Rotate too Slow”. 
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Driver sprawdza ruch klapy na dwóch poziomach: 

1) po wydaniu rozkazu otwarcia lub zamknięcia sprawdzane jest czy stan odpowiedniego 

wyłącznika krańcowego klapy zmienił się w zadanym czasie.  

2) sprawdzany jest całkowity czas otwierania lub zamykania klapy. 

 

Decydują o tym parametry: 

a) Config>Shutter>Shutter Movment Limits>Start delay (oczekiwanie na zmianę stanu sensora 

klapy) 

b) Config>Shutter>Shutter Movment Limits>Max opening time (oczekiwanie na całkowite 

otwarcie klapy) 

 
Jeśli w zadanym czasie nie nastąpi zdarzenie oczekiwane przez driver – silnik klapy zostanie 

wyłączony. 

 

 

Quick Help  

Jest to automatycznie pojawiające się okno z podpowiedziami. Po najechaniu myszką na dowolny 

element wyświetlają się związane z nim krótkie podpowiedzi  i objaśnienia funkcji programu. 

 

 

Żeby ją włączyć należy zaznaczyć checkbox: Config>Program>Program>Quick Help. 
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Instalacja Drivera 

Opis procedury instalacji znajdziecie w pliku  

c:\ScopeDome\Doc\Software_installation_instructions_EN - 5.5.5.18.pdf. 

Program można zainstalować na komputerze PC z systemem operacyjnym Windows w wersji XP lub 

nowszej. Program do prawidłowego działania wymaga zainstalowania platformy ASCOM w wersji 6.4 

lub 6.5 oraz środowiska .Net w wersji 3.51 lub nowszej. 

Uwaga: Przed instalacją nowej wersji należy koniecznie odinstalować starszą wersję drivera.  

Przed odinstalowaniem drivera można zapisać jego konfigurację do pliku używając przycisku:  

Config>Program>Save/Load Config to File>Save 

Po zainstalowaniu nowej wersji można załadować starą konfigurację używając przycisku: 

Config>Program>Save/Load Config to File>Load  

 

Ustawienia zapisywane są domyślnie w pliku C:\ScopeDome\ScopeDome_Config.ini 

Uwaga: Instalator ASCOM 6.5 domyślnie nie instaluje programów POTH i HUB. Jeśli zamierzacie ich 

używać do połączenia z teleskopem należy podczas instalacji platformy ASCOM 6.5 zaznaczyć 

odpowiednie opcje. 

Podstawowe testy działania drivera i mechanizmów napędowych kopuły  

Uwaga: Driver wymaga by wszystkie elementy kopuły (karta sterująca, silniki kopuły, wyłączniki 

krańcowe, Home Sensor, encoder, teleskop) działały prawidłowo.  Po zmontowaniu kopuły i 

instalacji oprogramowania należy sprawdzić ich działanie.  

Jeśli po przeczytaniu tej instrukcji w dalszym ciągu nie wiedzą Państwo co zrobić lub karta wam 

nie działa, prosimy o kontakt do nas przez email z opisem problemów. Postaramy się jak 

najszybciej zweryfikować powstały problem. W celu umożliwienia zdalnej diagnostyki prosimy o 

instalację  lub uruchomienie aktualnego oprogramowania TeamViewer i podłączenie kamery 

internetowej, która pozwoli nam zorientować się jak wygląda Państwa kopuła, teleskop, instalacja 

zasilająca itp.  

Typowa sesja serwisowa trwa około 2 godzin. 

Pierwsze kroki konfiguracji drivera 

Po instalacji driver uruchamia się w trybie symulatora kopuły 3M. Aby do końca skonfigurować 

driver i połączyć go fizycznie z kartą należy wykonać poniższe kroki: 

1. Wybierz typ kopuły:  

- parametr Config> Card>Card and Dome Type>Dome Type 

2. Wybierz odpowiedni typ karty:  

- parametr Config> Card>Card and Dome Type>Card Type 
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3. Zapisz ustawienia (to bardzo ważne – dzięki temu driver wie jak powinien odtwarzać 

ustawienia domyślne): 

- przycisk Config> Card>Save Settings 

4. Odtwórz ustawienia domyślne:  

- przycisk Config> Card>Card and Dome Type>Restore Default 

5. Wybierz sposób połączenia z kartą (Ethernet lub USB):  

- parametr Config> Card>ScopeDome Arduino Card>Connect by 

6. Podaj adres IP lub numeru portu COM:  

- parametr Config> Card>ScopeDome Arduino Card>Ip Address: 

- lub parametr Config> Card>ScopeDome Arduino Card>Com Port 

 

 
7. Ponownie zapisz ustawienia (od tej chwili driver wie jak łączyć się z twoja kartą): 

- przycisk Config>Save Settings 

8. Prześlij ustawienia do karty: 

- przycisk Config>Card and Dome Type>Send config to card 

9. Zamknij okno Config i główne okno programu klikając Exit. 

10. Odczekaj kilka sekund uruchom driver ponownie. 

 

Po ponownym uruchomieniu driver powinien połączyć się z kartą sterującą obserwatorium. 

Błędy połączenia z kartą są wyświetlane w oknie: ScopeDome LS>Main>Command Monitor. 

Jeśli nie wystąpił błąd połączenia okno monitora komend pozostanie puste. W przeciwnym 

przypadku pojawią się komunikaty o braku połączenia: 

 

Driver będzie używał standardowej konfiguracji typowej dla wybranego typu kopuły.  

Standardowe pliki konfiguracyjne dla wszystkich typów kopuł zapisane są w katalogu:  

c:\ScopeDome\ _Def_Config_Files i nie należy ich zmieniać. 
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Test działania połączenia komputera z kartą  

Najprościej jest przetestować działanie połączenia karty z komputerem poprzez test przekaźników 

„Telescope” lub „CCD”. Po naciśnięciu na karcie przycisku sterującego przekaźnikiem odpowiednia 

ikona powinna zmienić swój stan w oknie drivera i przekaźnik powinien się załączyć.  

Przed naciśnięciem przycisku Telescope: 

 

Po naciśnięciu przycisku Telescope: 

 

Błędy połączenia z kartą są wyświetlane w oknie Command Monitor: 

 

Jeśli po uruchomieniu drivera okno jest puste – to znaczy, że driver prawidłowo połączył się z kartą 

lub działa w trybie symulatora kopuły. 

Ustalenie pozycji Home Sensora i sposobu jego działania 

Prawidłowe działanie Home Sensora kopuły jest kluczowe dla funkcjonowania drivera. Wyznacza on 

wyjściową (zerową) pozycję kopuły i na tej podstawie wyliczana jest pozycja kopuły podczas jej 

obrotów.  

 

Gdy Home Sensor jest aktywny licznik enkodera pozycji kopuły musi mieć wartość zero. Od czasu do 

czasu warto zweryfikować wartość licznika enkodera i w razie potrzeby zresetować go. Bieżąca wartość 

licznik jest prezentowana na linii statusu (dolnej belce) panelu głównego programu (Enc: 0 ):  

 

 
 

Jeśli Home Sensor nie jest umieszczony na południu (klapa wskazuje wtedy na północ) to należy podać 

jego pozycję – parametr Config>Dome>Dome Geometry> Home Sensor Position 

Można wpisać ten kąt ręcznie  lub obliczyć go przy pomocy przycisku Set.  
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Użycie przycisku Set  

a) przesunąć kopułę do pozycji AtHome (np. przy pomocy funkcji ScopeDome LS>Main>Goto> Find 

Home) 

b) zresetować licznik pozycji kopuły (przycisk Config>Card>Dome Counters and encoder calib.> Reset 

Encoder ENC = 0) 

c) obrócić kopułę - tak by środek klapy był skierowany dokładnie na północ 

d) nacisnąć przycisk Config>Dome>Dome Geometry> Home Sensor Position>Set 

 

Działanie Home Sensor’a można także sprawdzić ręcznie.  

W tym celu wystarczy wsunąć w szczelinę czujnika kartkę papieru i obserwować główne okno drivera. 

Po przesłonięciu czujnika driver powinien wyświetlić w kolorze czerwonym napis AtHome: 

 
Do karty można podłączyć różne czujniki pozycji „home” kopuły. Mogą one zwracać wartość jeden lub 

zero gdy czujnik jest aktywny (np. stare wersje czujników Scopedome Home Sensor, lub kontaktrony). 

Driver pozwala na zanegowanie wartości zwracanej przez sensor. Służy do tego znacznik: 

Config>Card>Card Configuration> Negative Home Sensor . Zaznaczenie go spowoduje zanegowanie 

sygnału z Home Sensora.  

 

Po zmianie tego parametru należy koniecznie zapisać ustawienia (przycisk Config>Card>Save Settings), 

a następnie przesłać je do karty (przycisk Config>Card>Send config to card) oraz zrestartować driver. 

 

Napis AtHome w oknie drivera powinien być wyświetlany tylko wtedy gdy Home Sensor jest 

przesłonięty (aktywny). 

Jeśli mamy nieprawidłowo ustawiony parametr Negative Home Sensor – ten napis pojawia się zawsze 

i znika gdy Home sensor jest aktywny (przesłonięty). 

 

Uwaga: Home Sensor jest wrażliwy na światło słoneczne. Czujnik oświetlony bezpośrednio 

promieniami Słońca może nie działać prawidłowo. Równie groźne są pajęczyny lub kurz – od czasu 

do czasu należy oczyścić Home Sensor i fotodiodę sprężonym powietrzem lub czystą, nie 

pozostawiającą włókien szmatką.  

 

Działanie Home Sensora jest uzależnione od pozycji diafragmy (metalowa elastyczna blaszka 

przykręcona do tylnego panelu kopuły) należy zadbać o to by diafragma miała odpowiednią długość i 

pozycję. Musi ona podczas obrotów kopuły stabilnie i skutecznie zasłaniać fotodiodę wewnątrz 

czujnika. Poprawne ustawienie diafragmy prezentują poniższe zdjęcia: 

 

 
 

Przykładowe ustawienia Home Sensora i diafragmy znajdą Państwo w pliku:  

Doc/Home Sensor Adjustment.pdf 
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Sprawdzenie działania enkodera pozycji kopuły 

To bardzo ważny podzespół decydujący o działaniu drivera i dokładności pozycjonowania kopuły. 

Podczas ruchu kopuły dioda „Encoder” na panelu karty powinna mrugać (zapalać się i gasnąć).  

 

Nieprawidłowe ustawienie czujnika optycznego względem tarczy enkodera zamocowanej na osi silnika 

może powodować niestabilne lub mylne odczyty pozycji kopuły. W takiej sytuacji impulsy z enkodera 

mogą nawet w ogóle nie być zliczane i driver zgłosi błąd „Dome rotate too slow”, pomimo że kopuła 

się obraca. 

 

Sprawdzenie działania enkodera najprościej jest zrobić w pozycji AtHome kopuły.  

W tym celu należy: 

a) ustawić kopułę w pozycji AtHome ( sensor AtHome musi być aktywny ) 

b) zresetować licznik kopuły (ENC=0) (przycisk Config>Card>Dome Counters and encoder calib.> Reset 

Encoder ENC = 0) 

c) używając funkcji ScopeDome LS>Main>Dome commands>ENC. GoTo przesunąć kopułę do pozycji 

200  

d) używając funkcji ScopeDome LS>Main>Dome commands>ENC. GoTo przesunąć kopułę z powrotem 

na pozycję 0 (zero) 

 

Po tych operacjach kopuła powinna wrócić na pozycję Enc = 0 i czujnik AtHome powinien być aktywny. 

Jeśli za każdym razem kopuła wraca do pozycji AtHome to znaczy, że enkoder działa prawidłowo.  

 

Warto powtórzyć te kroki dla różnych wartość ScopeDome LS>Main>ENC. GoTo (np. 300, 500, -200, -

300, -500).  

 

Jeśli enkoder nie działa prawidłowo to warto sprawdzić: 

a) czy kółko zębate napędu kopuły ściśle przylega do listwy zębatej na całym obwodzie kopuły. W razie 

konieczności dokonać regulacji położenia silnika obrotów kopuły zatrzymując kopułę w tym miejscu. 

b)  czy tarcza enkodera wewnątrz obudowy nie poluzowała się. Np. czy. śruba mocująca ją do osi nie 

poluzowała się podczas transportu lub użytkowania i czy tarcza obraca się wraz z osią koła zębatego 

c) czy tarcza enkodera znajduje się blisko jednej z krawędzi czujnika optycznego (normalnie powinien 

być umieszczony w okolicy 1/3 szerokości szczeliny czujnika 

d) czy czujnik optyczny enkodera nie jest zabrudzony 

e) czy przewody enkodera są prawidłowo połączone do karty 

  



  
Str: 12 

Sprawdzenie działania wyłączników krańcowych klapy 

Wyłączniki krańcowe w kopułach ScopeDome pełnią jednocześnie dwie funkcje: 

a. przekazują do drivera stan klapy (otwarta/zamknięta) 

b. fizycznie odcinają sygnał sterujący silnikiem okna kopuły i po wciśnięciu zatrzymują go 

Jedna para styków wyłącznika krańcowego (NO – normal open/normalnie otwarta) służy do 

przekazywania sygnału  otwarcia/zamknięcia klapy, druga z nich (NC – normal close/normalnie 

zamknięta) służy do odcinania sygnału sterującego silnikiem. 

Uwaga: Aby sprawdzić czy wyłączniki krańcowe działają prawidłowo należy najpierw przy pomocy 

przycisków na karcie ustawić klapę tak by była w połowie otwarta. 

Sprawdzenie działania sensora zamknięcia klapy 

W tym celu należy złamać ramię wyłącznika krańcowego „Close” (symulując załączenie go przez 

płytkę dociskową zamontowaną na klapie) i sprawdzić stan klapy w driverze.  

Znacznik ScopeDome LS> Shutters>Shutter 1> Close Sensor 1  powinien być aktywny a po 

zwolnieniu ramienia wyłącznika powinien się dezaktywować: 

 

 

Analogicznie  postępujemy z sensorem otwarcia klapy (umieszczonym na górze kopuły). 

 

Przycisk Reset służy do wyzerowania licznika pozycji klapy. Jeśli podczas otwierania lub zamykania 

klapy program pokazuje zły kąt (wartość „Degree”), należy po jej zamknięciu zresetować licznik 

pozycji klapy. Podczas następnego otwarcia klapy oprogramowanie zmierzy niezbędne parametry 

i przy następnym otwarciu klapy powinien pokazywać prawidłowe wartości. 

Sprawdzenie działania odcinania sygnałów sterujących silnikiem klapy. 

Ten test należy przeprowadzać przy pomocy dwóch osób, przy wyłączonym oprogramowaniu 

sterującym na komputerze. Jedna z osób przyciska guzik Open lub Close na karcie, a druga 

przerywa jego działanie aktywując wyłącznik krańcowy. Po złamaniu ramienia wyłącznika 

krańcowego klapa powinna się zatrzymać. 
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Konfiguracja połączenia z teleskopem 

Żeby automatycznie zsynchronizować pozycje kopuły z pozycją teleskopu niezbędne jest przekazanie 

do drivera informacji o jego pozycji, parametru „PierSide” (czyli po, której stronie słupa znajduje się 

teleskop) oraz współrzędnych geograficznych obserwatorium. 

 

Driver najlepiej współpracuje z teleskopem poprzez platformę ASCOM. Możliwe jest też podłączenie 

teleskopu poprzez oprogramowanie TheSkyX, TheSky6, CartesDuCiel lub poprzez plik w formacie XML. 

 

Z poziomu platformy ASCOM najlepiej jest łączyć się z teleskopem poprzez hub pracujący w trybie 

Local Server. Najczęstszym błędem popełnianym przez użytkowników jest podłączenie drivera ASCOM 

teleskopu do dwóch programów na raz np. do MaximDL i jakiegoś atlasu nieba. Powoduje to zwykle 

zawieszenie się sterownika teleskopu, a w następnej kolejności całej platformy ASCOM w tym drivera 

kopuły.  

Aby uniknąć takiej sytuacji, najpierw podłączamy sterownik teleskopu np. do POTH Hub, a następnie 

POTH Hub konfigurujemy jako driver teleskopu w pozostałych programach czyli w MaximDL, TheSkyX 

oraz w ScopeDomeDriver. 

Uwaga: platforma ASCOM ver. 6.5 domyślnie nie instaluje modułu POTH, należy podczas instalacji 

ręcznie wybrać niezbędne opcje dodatkowe lub skonfigurować połączenie z teleskopem poprzez 

ASCOM Chooser>Device Hub. 

 

Przykładowa konfiguracja dla ASCOM 6.5 poprzez Device HUB: 

 
Należy sprawdzić czy we wszystkich programach sterujących teleskopem mamy podane takie same 

współrzędne geograficzne obserwatorium. Wszystkie programy komunikujące się z teleskopem muszą 

przekazywać te same współrzędne geograficzne teleskopu:  

 

Przyciski Get i Set pozwalają na przesłanie i pobranie współrzędnych obserwatorium z drivera 

teleskopu o ile wybrany driver ASCOM realizuje tę funkcję. 
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Parametr „SideOfPier” 

PierSide (lub SideOfPier) to po współrzędnych geograficznych najważniejszy parametr decydujący 

o poprawnej synchronizacji pozycji kopuły z teleskopem. Jego wartość jest uzależniona jedynie od 

sposobu działania drivera teleskopu i każdy z producentów może stosować własne rozwiązanie 

poprawnego przekazywania tego parametru. W związku z tym, że nie ma jednoznacznego 

standardu i tym samym nie ma jednej uniwersalnej metody konfiguracji tego parametru.  

W driverze ScopeDome, zostało udostępnionych kilka opcji konfiguracji tego parametru 

Config>Telescope>SideOfPier 

 
 

Zwykle najlepiej działającą opcją jest Calculate SideOfPier, jednak dla niektórych teleskopów 

dobrym wyborem jest Use SideOfPier from scope. Zazwyczaj należy zaznaczyć również opcję 

Invers SideOfPier.  

 

Opcja Use SideOfPier from scope powoduje, że ScopeDome czyta parametr  SideOfPier wprost ze 

sterownika teleskopu.  

 

Opcja Calculate SideOfPier używa wbudowanego w driver ScopeDome algorytmu do wyliczania 

wartości tego parametru na podstawie współrzędnych teleskopu. Warto jednak pamiętać, że 

wszystko zależy od początkowego ustawienia teleskopu po wschodniej lub zachodniej stronie. W 

takim przypadku może być pomocna opcja  Invers SideOfPier, która pozwala na szybkie 

zanegowanie jego wartości.  

 

Opcja Use SideOfPier form diagram jest ostatecznym wyborem jeśli nie działają opisane powyżej 

opcje.  Pozwala na zdefiniowanie dowolnej wartości SideOfPier w zależności od tego, na którą 

część nieba patrzy teleskop. Nie polecamy jednak Państwu używanie tej opcji. Jej poprawna 

konfiguracja jest bardzo skomplikowana. 

 

 
 

Aby znaleźć poprawne ustawienie dla używanego teleskopu należy eksperymentalnie 

wypróbować różne ustawienia lub porozmawiać z innymi użytkownikami kopuł SopeDome, którzy 

mają podobny do Państwa rodzaj teleskopu – z pewnością będą Państwu w stanie podpowiedzieć 

najlepszy sposób współpracy kopuły i teleskopu. Należy także pamiętać, że równie istotne jak 

PierSide jest prawidłowe podanie parametrów X, Y, Z, GEM i współrzędnych obserwatorium. Jeśli 

parametry te są źle wprowadzone synchronizacja okna kopuły z teleskopem nie będzie działać 

poprawnie. Kluczowy jest parametr GEM, który ma największy wpływ na działanie synchronizacji 

kopuły z teleskopem. 
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Wybór  sposobu odczytu sensora AtPark Teleskopu 

 
- Opcja „Telescope Driver AtPark Solution” 

ScopeDome driver do odczytu stanu AtPark teleskopu będzie używał funkcji  AtPark 

drivera teleskopu 

- Opcja Telescope Alt/Az Position 

ScopeDome driver do odczytu stanu AtPark teleskopu będzie używał współrzędnych 

Alt/Az teleskopu 

- Opcja ScopeDome Card Telescope AtPark Sensor 

ScopeDome driver do odczytu stanu AtPark teleskopu będzie używał  wejścia 

TelescopeAtPark karty ScopeDome 

 Wybór sposobu parkowania teleskopu 

 
- Opcja „Telescope Driver AtPark Solution” 

ScopeDome driver do parkowania teleskopu będzie używał funkcji  Park drivera 

teleskopu 

- Opcja Telescope Alt/Az Position 

ScopeDome driver do parkowania teleskopu będzie używał funkcji GoTo Alt/Az 

teleskopu 

 

Przycisk „Get Current Position” przepisuje aktualną pozycje teleskopu do parametrów Altitude 

i Azimuth współrzędnych teleskopu – pozwala to na szybkie wprowadzenie współrzędnych 

parkowanie teleskopu.  
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Przykładowe ustawienia dla TheSkyX, Patamont MYT, TEC140 w naszym obserwatorium w 

Otivar - Hiszpania 

Interesującym jest fakt, że w przypadku takiej konfiguracji jedynie współpraca poprzez driver 

ASCOM (a nie bezpośrednio przez TheSKyX) umożliwia prawidłową synchronizację teleskopu z 

kopułą. Używamy takiej konfiguracji od kilku miesięcy i nie zauważyliśmy jakichkolwiek 

problemów we współpracy kopuły z  teleskopem. 

 

 

 

Konfiguracja geometrii kopuły (X, Y, Z, GEM) i współrzędnych obserwatorium 

Parametry X,Y,Z Gem decydują o dokładności synchronizacji pozycji kopuły i teleskopu. 

Precyzyjnie zmierzone parametry pozwalają na osiągnięcie centymetrowej precyzji ustawień 

środka klapy kopuły względem kierunku osi optycznej teleskopu. Należy pamiętać, że parametry 

X, Y, Z odnoszą się do punktu przecięcia się osi RA i DEC teleskopu, a nie środka słupa. Więcej 

informacji o wyznaczaniu tych parametrów znajdą Państwo w pliku: 

Doc/Dome Geometry - Additional Information.pdf 
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Włączenie systemu ogrzewania karty i silników kopuły 

Kopuły pracują w różnych warunkach pogodowych. Często podczas nocy wilgotność jest większa niż 

80%, a temperatury spadają poniżej zera. Podczas wilgotnych nocy na elektronice osadza się wilgoć 

powodująca zwarcia, korozje ścieżek oraz uszkodzenia elelemntów elektronicznych. Natomiast niskie 

temperatury powodują gęstnienie smarów w przekładniach silnika co powoduje trudności w 

poruszaniu klapą kopuły. 

 

Uwaga: Dla zapewnienia bezawaryjnygo działania elektroniki i silników niezbędne jest ich 

ogrzewanie przez 24h na dobę.  

 

Ustawienia dotyczące ogrzewania obudów, silników i ustawień z nim związanych znajdują się w 

zakładce Config>Heating 

 

 
W pole Temperature należy wprowadzić żądaną wartość temperatury silników i obudów elektroniki, 

która ma być utrzymywana, a następnie kliknąć w przycisk Enable. 

Naciśnięcie przycisku Disable wyłącza ogrzewanie silników i obudów. 

 

Driver zakłada, że grzałki elektroniki i silnika są podłączone odpowiednio do przekaźników REL4 i REL5 

karty. Temperatura elektroniki jest mierzona przez termometr wbudowany na karcie, temperatura 

silnika jest mierzona przez termometr podłączony do wejścia OW1. Termometr silnika powinien być 

przykręcony do motoreduktora silnika w jak największej odległości od grzałki silnika. 
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Włączenie ogrzewania luster teleskopu 

Ogrzewaniem lustra można sterować na trzy sposoby: 

1. podając wypełnienie (procent mocy) z jaką ma pracować wybrana grzałka, a następnie nacisnąć 

przycisk ScopeDome LS>Relays>Dome Relays>Set 

 

 

2. podając w oknie Config>Heating>Mirror 1/2 heating zadaną temperaturę lustra, a następnie 

nacisnąć przycisk Enable: 

 

3. podając w oknie Config>Heating>Mirror 1/2 heating  różnicę temperatur lustra w stosunku do 

temperatury otoczenia, 

    a następnie nacisnąć przycisk Enable: 

 

Driver zakłada, że lustra (lub soczewki) teleskopu są ogrzewane poprzez wyjścia PWM karty.  

Schemat połączeń grzałek i termometrów znajdą Państwo w manualu do karty, na stronie 14 i 15-stej 

(ScopeDome_Arduino_Card_Manual). Do wyjścia PWM1 należy podłączyć grzałkę lustra numer 1, do 

wyjścia PWM2 grzałkę lustra numer 2. Temperatura zewnętrzna jest mierzona przez termometr 

podłączony do wejścia OW2 karty Shutter (Slave). 

 

Należy pamiętać, że maksymalny prąd płynący przez grzałkę to 2A (24W). Włączenie ogrzewania luster 

będzie wymagać dodatkowej mocy ok. 50W i wymiany zasilacza karty na taki, który obsłuży większe 

zapotrzebowanie na moc.  

Uwaga: Sugerujemy zastosować zasilacz o mocy minimum 100W.  

https://www.scopedome.com/wp-content/uploads/2020/10/ScopeDome_Arduino_Card_Manual_EN-1.pdf
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Konfiguracja połączenia ze stacją pogodową 

 

 

Driver ma wbudowaną obsługę wielu popularnych stacji pogodowych. Ustawienia dotyczące 

wyboru stacji pogodowej do współpracy z programem znajdują się w zakładce Config>Weather 

 

Dane ze stacji odczytywane są z pliku logu zapisywanego przez stację pogodową  w formacie CSV 

w systemie plików komputera. Wyjątkiem są „ASCOM Observing Hub”, „ASCOM Open Weather 

Map” oraz „ScopeDome Cloud Sensor”, które nie wymagają pliku wymiany danych (logu). 

Dla stacji typu „Weater Underground API” wymagane jest podanie adresu www linku do danych 

ze stacji oraz wpisanie własnego klucza API do tych danych np.: 

https://api.weather.com/v2/pws/observations/current?stationId=NAME&format=xml&units=m&

apiKey=dcaca713088fa49c78a713088fa09c7a7 

gdzie:  

NAME – to nazwa twojej stacji pogodowej  

dcaca713088fa49c78a713088fa09c7a7 – twój unikalny ApiKey 

 

Działanie połączenia z „Weather Underground API” można przetestować wpisując ten adres do 

przeglądarki – w odpowiedzi powinni Państwo otrzymać typowy plik xml z aktualnymi danymi. 

Weather.com zlicza liczbę odczytów danych na godzinę i przy zbyt częstych odczytach blokuje 

dostęp do danych. Sugerujemy by odczytywać dane nie częściej niż raz na 5 minut (parametr 

„Weather Scan Interval”. 

Przykładowy format pliku dla popularnej stacji pogodowej (a zarazem czujnika chmur)  

„AAG CloudWatcher”: 

https://api.weather.com/v2/pws/observations/current?stationId=NAME&format=xml&units=m&apiKey=dcaca713088fa49c78a713088fa09c7a7
https://api.weather.com/v2/pws/observations/current?stationId=NAME&format=xml&units=m&apiKey=dcaca713088fa49c78a713088fa09c7a7
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"Date","Time","Cloud Condition","Rain Condition","Brightness Condition","Cloud Value","Cloud Sensor Temperature","Rain 

Value","Brightness Value","Ambient Temperature","Rain Heating Percentage","Rain Sensor Temperature","Heating Status","Switch 

Status","Read Cycle","Timeout Errors","Safe Status","Wind Condition","Wind Value","Rel hum Condition","RH Value" 

"2020-04-17","20:23:58","Cloudy","Dry","Dark","-

15.6","10.3","4544","2868","10.3","20%","18.0","","Closed","5","0","Unsafe","Windy","7.0","Dry","50%" 

Aby podłączyć stacje pogodową do drivera należy wybrać jej typ z listy w polu 

Config>Weather>Weather Station Config>Weather Station Type następnie wskazać plik logu 

zapisywanego przez stację w polu Config>Weather>Weather Station Config>Current Weather 

Data File Name, a następnie ponownie uruchomić driver. 

 

Problemem jest to, że producenci stacji pogodowych bardzo często zmieniają format pliku logu z 

danymi stacji. Dodatkowo, format pliku może również zależeć od ustawień regionalnych systemu 

Windows (znaki służące do separacji liczb). Powoduje to błędy w odczycie danych z pliku z danymi 

stacji pogodowej 

 

Jeśli mają Państwo trudności z podłączeniem stacji pogodowej, prosimy o kontakt z nami. Zwykle 

jesteśmy wstanie pomóc w ciągu kilku dni. Zazwyczaj niezbędna jest zdalna sesja serwisowa lub 

przesłanie do nas Państwa logu danych ze stacji pogodowej i linku do jej instrukcji obsługi. 

Lista stacji pogodowych obsługiwanych przez driver: 

1. ScopeDome Cloud Sensor 

2. Heavy Weather 

3. HeavyWeather PRO WS 2800 

4. Boltwood Cloud Sensor (from current date log - eq. 2020-02-26.txt) 

5. Boltwood Cloud Sensor (Single Line - New Format) 

6. AAG CloudWatcher 

7. Davis Vantage Pro 

8. Sirene 

9. Virtual Weather Station 

10. Sentinel Weather Station 

11. Cumulus 

12. Weather Display 

13. EMA 

14. Davis Ventage Vue (WeatherLink) 

15. EasyWeather v6.2 

16. ASCOM Observing Condition Hub 

17. ASCOM Open Weather Map 

18. WeatherLink 

19. SkyAlert 

20. Weater Underground API 
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Konfiguracja połączenia z czujnikiem chmur 

Konfiguracja czujnika chmur jest identyczna jak dla stacji pogodowej. Aby podłączyć czujnik chmur 

do drivera należy wybrać jego typ z listy w polu Config>Weather>Cloud Sensor Config>Cloud 

Sensor Station Type następnie wskazać plik logu zapisywanego przez czujnik w polu 

Config>Weather>Cloud Sensor Config>Current Cloud Sensor Status File Name, a następnie 

ponownie uruchomić driver. 

 
Jeśli stacja pogodowa ma zintegrowany czujnik chmur to wystarczy jeśli skonfigurujecie go w 

sekcji stacji pogodowej. 

Konfiguracja ScopeDome Cloud Sensor 

ScopeDome Cloud Sensor do prawidłowego działania wymaga podania różnicy temperatury 

otoczenia i temperatury nieba odczytywanej odpowiednio przez „Out Termometer”  i 

„Pirometer Sensor” 

 

Wartość tego parametru zależy od sposobu instalacji Cloud Sensora. Powinien on być 

skierowany tak by w jego zasięgu było tylko niebo nad obserwatorium, w szczególności nie 

powinien on obejmować drzew lub budynków. 

Przykładowo w Hiszpanii optymalną wartością wydaje się być -25 stopni.  

Podanie indexu równego -27 stopni – spowoduje większą czułość na wysokie chmury. 

Po zmianie parametru „Cloud Index” należy koniecznie zapisać ustawienia (przycisk „Save 

Settings”) a następnie przesłać je do karty (przycisk „Send Config to Card”).  

Lista cloud sensorów obsługiwanych przez driver: 

1. ScopeDome Cloud Sensor 

2. Boltwood Cloud Sensor (from current date log - eq. 2020-02-26.txt) 

3. Boltwood Cloud Sensor (Single Line - New Format) 

4. AAG CloudWatcher 

5. EMA 

6. Tektite 

7. Virtual Weather Station 

8. ASCOM Observing Condition Hub 

9. ASCOM Open Weather Map 

10. SkyAlert 
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Konfiguracja połączenia z Sky Quality Meter 

Sposób konfiguracji czujnika jakości nieba (SQM) jest identyczny jak dla stacji pogodowej lub 

czujnika chmur. 

Lista Sky Quality Meter obsługiwanych przez driver: 

1. SQM 

2. SQM Reader 2 

3. EMA 

4. ASCOM Observing Condition Hub 

5. ASCOM Open Weather Map 
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Konfiguracja warunków awaryjnego zamykania klapy 

 

To jeden z trudniejszych elementów konfiguracji działania drivera. Przede wszystkim należy 

rozróżnić zdarzenia związane z sprzętowymi wejściami na karcie  („Card inputs events”) od 

zdarzeń generowanych przez oprogramowanie („Software events”).  

„Card inputs events” są wyzwalane przez odpowiednie wejścia karty i obsługiwane na poziomie 

sprzętowym przez kartę. Co znaczy, że będą działać zawsze o ile karta ma zasilanie, bez względu 

na to czy w tym czasie działa komputer sterujący obserwatorium. 

 

„Software events” są generowane przez driver i obsługiwane z poziomu drivera uruchomionego 

na komputerze sterującym obserwatorium. Do ich poprawnego działania komputer w 

obserwatorium musi być włączony, połączony z kartą i musi mieć uruchomiony driver. 

Przykładowo, poniższy zapis oznacza, że karta co 5 sekund będzie sprawdzała stan wejścia „Cloud 

Sensor” i jeśli trzy razy pod rząd wejście to będzie aktywne – karta automatycznie zacznie 

zamykać klapę lub dach obserwatorium. 

 

 

 

Inaczej mówiąc jeśli trzy razy pod rząd w odstępach 5 sekund sensor będzie aktywny – klapa się 

zamknie. Czas po jakim klapa zamknie się od momentu aktywacji wejścia „Clousd Sensor” 

wyniesie : 5s   x   3clk  = 15 sekund. 

Uwaga: Nigdy nie wprowadzaj wartości zero w pola częstotliwości odczytów (s) i liczby 

wystąpień (clk). Spowoduje to zawieszenie się drivera. 

 

Jeśli w tym czasie (15s) wejście sensora na chwilę przestanie być aktywne, to karta zacznie 

zliczanie stanu aktywnego od początku, a klapa nie zamknie się. Pozwala to uniknąć 

niepotrzebnych zamknięć kopuły w sytuacji gdy pogoda jest niestabilna. Tak samo działają 

ustawienia dla pozostałych wejść karty zarówno sprzętowych jak i programowych. 
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Opis działania opcji Card inputs events 

• Cloud Sensor – zamyka klapę gdy wejście karty „Cloud Sensor” jest aktywne 

• Rain Sensor – zamyka klapę gdy wejście karty „Rain Sensor” jest aktywne 

• Cloudy (Pirometer Sensor) – zamyka klapę gdy ScopeDome Cloud Sensor wykryje 

zachmurzenie - działanie tej opcji jest zależne od wartości parametru Config>Weather 

>ScopeDome Cloud Sensor parameters>Cloud Index  

• No Power – zamyka klapę gdy karta wykryje, że na wejściu karty „230V Sensor” brak jest 

napięcia 230V. To opcja przydatna gdy obserwatorium zasilane jest przez UPS. Wejście 

sensora 230V należy podłączyć przed UPS’em. Jeśli UPS nie jest podłączony ta opcja nie 

zadziała. Czas zadziałania tego sensora należy ustawić  tak by baterie UPS’a pozwoliły na 

podtrzymanie zasilania na czas niezbędny do zamknięcia klapy obserwatorium. 

• Low UPS Battery – zamyka klapę gdy napięcie baterii w UPS’się jest zbyt niskie. Aby 

skorzystać z tej opcji należy podłączyć baterie UPS’a do wejścia „0-64 Voltage” zgodnie 

instrukcją karty (schemat na stronie 14-stej) i wprowadzić odpowiednią  wartość „Battery 

treshold” 

Opis działania opcji Software events 

• Lost internet connection – sprawdza czy komputer ma połączenie ze wskazanym adresem 

IP. Sprawdzanie polega na cyklicznym wysyłaniu PING’a pod wskazany adres IP (np. adres 

routera w sieci lokalnej 192.168.1.1) 

• Bad Weather – sprawdza czy stan wejścia Bad Weather jest aktywny  

• On Time – zamyka klapę o określonej godzinie 

• Shutter opened longer then – zamyka klapę jeśli jest otwarta dłużej niż wskazany okres 

czasu 

• Enable IP Watchdog – zaznaczenie tej opcji i przesłanie ustawień do karty spowoduje, że 

karta sama (bez udziału komputera) będzie pingować wskazany adres i w przypadku braku 

odpowiedzi zamknie klapę 

• Ip address for internet connection test – adres IP używany do funkcji Lost Internet 

Connection i IP Watchdog  

Opcja Bad Weather integruje stan wszystkich czujników pogodowych zarówno z wejść karty, 

ze stacji pogodowych jak i czujnika chmur.  

Będzie ona aktywna, gdy któryś z sensorów wykryje: chmury, deszcz lub zbyt silny wiatr. 

 

Maksymalną szybkość wiatru przy którym kopuła może pozostać otwarta ustalmy w polu 

Config>Weather>Hi Wind. Częstotliwość odczytów danych ze stacji pogodowych ustala się w 

polu Config>Weather>Weather Scan Interval: 

  

- parametr „Use Unsafe State from weather station log” pozwala na odczytywanie stanu 

Unsafe z logu czujnika chmur lub stacji pogodowej. Opcja jest szczególnie przydatna dla 

użytkowników AAG Cloud Sensor.  
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Reset licznika enkodera 

 

Driver do prawidłowej synchronizacji pozycji kopuły i teleskopu oraz zamykania klap wymaga by dla 

licznika encodera równego zero (Enc=0 ) aktywny był również czujnik „Home Sensor” 

To bardzo ważna funkcja dla użytkowników kopuł 4M i 55M oraz innych kopuł, w których klapa jest 

zasilana przy pomocy styków działających tylko w pozycji „At Home”.  

Ze względu na mechaniczne luzy (niedokładności) na przekładniach i zębatkach silnika obrotów kopuły 

co jakiś czas należy sprawdzić, czy dla licznika enkodera równego zero (Enc=0), kopuła zatrzymuje się w 

miejscu czujnika „Home Sensor”. Taki test warto zrobić nawet raz na miesiąc.  

Zdarza się również, że z powodu zawieszenia się karty lub komputera sterującego kopułą licznik 

enkodera w pozycji „At Home” ma wartość mniejszą lub większą od zera. Po tego typu awarii zawsze 

należy sprawdzić wartość enkodera w pozycji AtHome. 

Ręczny reset enkodera 

Jeśli jesteśmy w kopule to zwykle najszybciej jest wyzerować licznik enkodera ręcznie. 

Najpierw należy obrócić kopułę przy pomocy przycisków CW lub CCW na karcie - tak by Home 

Sensor był aktywny, a następnie przycisnąć przycisk Config>Card>Dome Counters and encoder 

calib.> Reset Encoder ENC = 0. Warto zwrócić uwagę na pozycję diafragmy przesłaniającej 

Home Sensor. Powinna ona być ustawiona na środku czarnego czujnika wewnątrz obudowy 

Home Sensora (mniej więcej w jednej trzeciej szerokości obudowy Home Sensora). 

Automatyczne znajdowanie pozycji zero enkodera 

  

Jeśli napęd obrotowy kopuły działa prawidłowo oraz stabilnie działa czujnik Home Sensor 

możemy użyć funkcji Find Home z głównego ekranu drivera. Kopuła zacznie się obracać do 

czasu aż trafi na Home Sensor. 
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Kalibracja enkodera 

Funkcja Calibrate Dome Encoder jest dostępna w zakładce  Config>Card>Dome Counters and encoder 

calib. 

 

Pozwala ona na sprawdzenie ile impulsów enkodera przypada na pełen obrót kopuły.  

Ta funkcja przyda się przede wszystkim właścicielom kopuł innych producentów niż ScopeDome. Dla 

kopuł ScopeDome jest ona odtwarzana z wartości domyślnych dla wybranego typu kopuły.  

 

Funkcja zadziała tylko wtedy, gdy działa czujnik HomeSensor – przed jej uruchomieniem należy 

sprawdzić jego działanie. 

 

Funkcję tą najlepiej jest uruchomić gdy kopuła jest w pozycji „At Home” – napis At Home na głównym 

panelu drivera musi być w kolorze czerwonym: 

 
 

Po naciśnięciu przycisku „Calibrate Dome Encoder” kopuła przesunie się o kilka stopni w kierunku CW, 

a następnie zacznie się obracać w kierunku CCW i będzie oczekiwała na kolejne dwie aktywacje Home 

Sensora. Liczba impulsów zliczona pomiędzy kolejnymi aktywacjami Home Sensora zostanie zapisana w 

polu  Config>Card>Card configuration>Encoder value for 360. Ta wartość wraz z pozycja Home Sensora 

pozwala na wyliczenie azymutu klapy kopuły w stopniach. 
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Kalibracja bezwładności silnika kopuły 

 
Funkcja Config>Card>Dome Counters and encoder calib.>Calibrate Dome Motor Inertia służy do 

poprawienia dokładności działania funkcji Main>GoTo i Main>Enc GoTo.  

Dzięki niej driver może uwzględnić masę i bezwładność kopuły. Kopuły są dość ciężkie, np. kopuła 3M 

waży ok. 200 kg, a kopuła 55M ponad 1000 kg. Nie jest łatwo wprawić je w ruch, a tym bardziej trudno 

jest je zatrzymać w wybranym miejscu z dokładnością do jednego impulsu enkodera, który odpowiada 

ok. 2mm obwodu kopuły. 

 

Dzięki tej funkcji kopuła szybciej trafi (bez zbędnych poprawek pozycji) na zadany kąt azymutu. Jest 

ona odpowiednikiem znanej wszystkim z montaży teleskopów funkcji regulacji luzu przekładni 

(backlash). 

 

Do prawidłowego działania tej funkcji niezbędne jest wcześniejsze sprawdzenie działania Enkodera i 

Home Sensora. Kopuła musi na całym obwodzie obracać się płynnie i bez zacięć, a enkoder zwracać 

prawidłowe wartości. Uruchomienie tej funkcji to też świetny test działania mechanizmu obrotowego 

kopuły. 

 

Po naciśnięciu przycisku „Calibrate Dome Motor Inertia” driver wykona od 120 do 150 testów ruchu 

kopuły.  Zajmie to ok. 20 minut. Podczas testu driver będzie wykonywał pomiary o ile różni się zadana 

przez funkcję EncGoTo liczba kroków enkodera od rzeczywistej osiągniętej przez kopułę pozycji, wyniki 

pomiarów po zakończeniu testu zostaną zapisane do pliku: ScopeDome_DomeInertia_Table.txt. 

 

Uwaga: Dla użytkowników kopuł ScopeDome 2M, 3M, 4M i 55M przygotowaliśmy typowe pliki, 

które są odtwarzane podczas konfiguracji drivera. O ile więc Państwa kopuły są prawidłowo 

zmontowane, nie ma potrzeby wykonywać tej procedury. 

 

 Typowy wygląd okna programu podczas kalibracji 

 

 
Jeśli w którymś z kolejnych kroków pojawi się informacja o błędzie należy ręcznie zmienić 

zawartość w pliku ScopeDome_DomeInertia_Table.txt  lub powtórzyć całą procedurę kalibracji. 

W razie problemów prosimy o kontakt z nami przez email.  

Mogą Państwo również po prostu skasować błędny plik ScopeDome_DomeInertia_Table.txt  

i zrestartować driver. Na dysku komputera, w katalogu c:\scopedome powinna być zapisana 

kopia pliku z przed procedury kalibracji, wystarczy zmienić jej nazwę aby przywrócić 

poprzednie wartości. 
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Opis zawartości plików logów zapisywanych przez driver 

Arduino_Commads_Log.txt  

• Loguje wszystkie komendy przesyłane przez driver do karty ScopeDome Adruino z 

wyjątkiem komendy GetStatus. 

Arduino_Error_Log.txt  

• Loguje niskopoziomowe błędy zgłaszane przez kartę. 

ScopeDomeCard_InternalSensors_Log.txt  

• Loguje dane o wartościach wszystkich wejść karty, zapisywany co 30 sekund. 

Cloud_Statistic.log  

• Loguje dane z Cloud sensora, zapis co 1 minutę. 

ScopeDomeCard_Log.txt  

• Loguje wszystkie operacje od użytkownika i z platformy ASCOM wykonywane przez 

driver. 

ScopeDomeCard_Error_Log.txt  

• Loguje wysokopoziomowe błędy karty. 

ScopeDomeCard_Log_ASCOM.txt  

• Loguje komendy przesyłane przez platformę ASCOM do drivera. 

Config_Change_Log.txt 

• Loguje zmiany w konfiguracji. 

Cloudy_Sensor_Status.txt 

• Podaje aktualny stan wejścia Cloudy (stan czujnika ScopeDome Cloud Sensor)  
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Najważniejsze funkcje drivera  

 

Otwieranie i zamykanie klapy 

Aby otworzyć lub zamknąć klapę kopuły należy przycisnąć przycisk Open lub Close w głównym 

oknie programu. Jeśli kopuła ma więcej niż jedną klapę automatycznie zostanie wykonana 

sekwencja komend otwierająca lub zamykająca poszczególne klapy w kolejności 3-2-1 dla 

otwierania i 1-2-3 dla zamykania. Aktywne klapy kopuły można zdefiniować w oknie 

Config>Shutter zaznaczając opcję Dome have shutter 1/2/3. 

 

Dodatkowo w zakładce Shutters można wydać komendę otwarcia klapy tylko do wybranego w 

polu GoTo kąta. Jeśli kopuła ma więcej klap możemy w tej zakładce pojedynczo  otwierać lub 

zamykać wybrane klapy. 

Przycisk Reset pozwala na zresetowanie licznika lub enkodera pozycji klapy. Przy następnej 

sekwencji otwarcia/zamknięcia klapy driver automatycznie obliczy wartość Max (maksymalna 

wartość licznika pozycji klapy) – co pozwoli na wybieranie kąta, do, którego ma się otworzyć 

klapa. 

 

Obracanie kopuły CW i CCW 

Po naciśnięciu tych przycisków kopuła zaczyna się obracać w wybranym kierunku tak długo, 

jak trzymamy wciśnięty lewy guzik myszy.  

Obracanie do wybranego kąta – GoTo 

Naciśnięcie przycisku Main>GoTo powoduje obrót kopuły do wybranego w polu obok przycisku 

kąta azymutu. Możemy ręcznie wpisać kąt lub wybrać go z listy. Można też wpisać wartość np. 5+ 

lub 5- co spowoduje obrócenie się kopuły o 5 stopni w stosunku do bieżącej pozycji. 

Dodatkowo możemy wydać komendy: 

• GoTo Scope – obrót kopuły do pozycji teleskopu 

• GoTo Home – obrót kopuły do pozycji Home Sensora 
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• Find Home – kopuła zacznie obracać się tak długo aż znajdzie Home Sensor 

• Park – obrót kopuły do pozycji AtPark zdefiniowanej w oknie Config>Dome 

• Derotate – to funkcja przeznaczona dla uzytkowników kopuł, w których klapa jest 

zasilana przewodowo. Pozwala ona na obrócenie kopuły w kierunku przeciwnym niż 

nawijający się przewód zasilający klapę 

 

Obracanie do wybranej pozycji enkodera – ENC. GoTo 

Oprócz obracania kopuły do zadanego azymutu możemy obracać kopułę do wybranej wartości 

enkodera.  

To funkcja przydatna podczas testów działania Home Sensora, enkodera i silnika obrotów kopuły. 

Dla przykładu: 

1. Ustawiamy ręcznie kopułę na Home Senor (ENC: 0) – tak by Home Sensor był aktywny 

2. Resetujemy licznik enkodera przy pomocy przycisku Config>Card>Dome Counters and encoder 

calib.> Reset Encoder ENC = 0. 

3. Obracamy kopułę kilka razy do pozycji ENC: 300 i z powrotem do pozycji ENC: 0 

4. Sprawdzamy czy kopuła nadal trafia w Home Sensor – znacznik AtHome musi się wyświetlać na 

czerwono 

Synchronizacja kopuły z pozycją teleskopu – Sync with Scope 

 

Naciśnięcie przycisku Scope OFF spowoduje, że kopuła zacznie synchronizować swoją pozycję z 

pozycją teleskopu. Przycisk po aktywacji zmieni swój kolor oraz opis na Scope ON. Należy 

oczywiście najpierw skonfigurować parametry X,Y,Z,Gem, PierSide oraz podać współrzędne 

obserwatorium. Niezbędne jest również skonfigurowanie połączenia z teleskopem. Teleskop musi 

być zsynchronizowany z niebem. 
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Synchronizacja z niebem – Sync with Sky  

 

To funkcja przeznaczona do wizualnych obserwacji – jej włączenie spowoduje, że kopuła zacznie 

wykonywać jeden obrót na 24h. 

Synchronizacja z kierunkiem wiatru – Sync with Wind 

 

Włączenie tej funkcji spowoduje, że kopuła zacznie się automatycznie ustawiać klapą w kierunku 

wiatru – jest to przydatne w przypadku gdy zapowiadane są silne wiatry, które mogły by uszkodzić 

kopułę 

Ochrona przed złymi warunkami pogodowymi – Weather Prot. 

 

Po włączeniu tej funkcji driver automatycznie zamknie kopułę i wymusi synchronizację z 

kierunkiem wiatru. Funkcja wyzwalana jest przez znacznik Bad Weather. Pozwala to mieć 

pewność, że w przypadku opadów deszczu lub zbyt silnego wiatru, kopuła zamknie się sama, bez 

udziału użytkownika. 

Znajdowanie pozycji Home 

Aby znaleźć pozycje Home Sensora należy użyć funkcji GoTo>Find Home. Po jej wybraniu z listy 

zostanie wyświetlone ostrzeżenie, że kopuła może się obracać poza zakresem limitów określonych 

w Config>Card>Card Configuration>Encoder Max Value/ Encoder Min Value. 
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Odtwarzanie ustawień fabrycznych drivera i zapis konfiguracji do pliku 

 

Aby odtworzyć ustawienia fabryczne drivera należy: 

1. Wybrać typ kopuły i karty 

2. Nacisnąć przycisk Save Settings na dole okna Config 

3. Nacisnąć przycisk „Restore Default” 

4. Następnie należy od początku wprowadzić sposób połączenia z kartą. 

Upgrade firmware - oprogramowania wewnętrznego karty 

Upgrade firmware można zrobić tylko poprzez złącze USB. Należy zawsze wgrywać tą samą wersję 

oprogramowania do obu kart: Dome i Shutter. 

Prosimy zapoznać się z filmem na stronie:  Facebook  

( https://www.facebook.com/1338769339600016/videos/1483129165182748 ) 

 

 

 

 

 

 

https://www.facebook.com/1338769339600016/videos/1483129165182748
https://www.facebook.com/1338769339600016/videos/1483129165182748
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Konfiguracja sensora  „Bad Water” (od wersji 5.5.29) 

Sensor „Bad Wearther” to jedna z najciekawszych funkcji driwera. Jego głównym zadaniem jest 

zamykanie kopuły w przypadku złych warunków pogodowych.  Funkcję tą można włączyć poprzez 

zaznaczenie opcji „Bad Weather” w oknie Config>Shutter Events> Close Shutter on driver events> 

lub naciskając przycisk „Weather Protect” w głównym oknie programu. 

 

Stan sensora jest wyświetlany w głównym oknie programu w zakładce Weather>Weather 

Condition Info: 

 

Jeśli opcja Bad Weather jest zaznaczona to program sprawdza co 6s (s) czy są złe warunki 

pogodowe i jeśli taki stan nie będzie zmieniał się przez 10 kolejnych testów (clk) driwer zacznie 

zamknąć klapę obserwatorium.  

Jednocześnie zostanie przekazany status Observatory Unsafe poprzez interface ASCOM Safety 

Monitor – ale dopiero wtedy gdy minie odpowiednia ilość testów ustalonych przez parametr 

period i clk zadanych dla Safety Monitor. 

Bad Weather sensor łączy dane z wielu urządzeń:  

- stacji pogodowej,  

- czujnika chmur,  

- sensora Sky Quality Meter (SQM)   

 

Jeśli jako stacja pogodowa lub sensor chmur wybrany zostanie ScopeDome Cloud Sensor to 

program uwzględni również dane z podłączonego do karty czujnika temperatury i wilgotności 

(ScopeDome Humidity Sensor) . 

Dodatkowo na podstawie współrzędnych obserwatorium podanych w konfiguracji driwera 

obliczana jest godzina wschodu i zachodu słońca – co pozwala na określenie kiedy zaczyna się noc 

i dzień.  

W połączeniu z wbudowanymi w driwer modułami ASCOM Safety Monitor i ASCOM Observatory 

Condition Hub (OCH) pozwala to na przesyłanie stanu kopuły oraz danych ze stacji pogodowych 

do innych programów sterujących sesją obserwacyjną takich jak N.I.N.A, ACP. Voyger, SQP i 

przerywanie jej w zależności od warunków pogodowych. 
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Sensor Bad Weather może być aktywowany poprzez: 

- Deszcz 

- Silny wiatr 

- Chmury 

- Za dnia (po wschodzie słońca) 

- Stan Unsafe przesłany poprzez log Cloud Sensora (np. AAG) 

- Stan Relay Switch Closed przesłany poprzez log Cloud Sensora (np. AAG) 

- Stan Relay Switch Opened przesłany poprzez log Cloud Sensora (np. AAG) 

- Zbyt wysoką temperaturę otoczenia 

- Zbyt niską temperaturę otoczenia 

- Zbyt dużą wilgotność 

- Zbyt małą jakość gwizd przesłaną przez sensor Sky Quality Meter (SQM) 

Wystąpienie każdej z tych sytuacji z osobna będzie aktywować sensor. Np. mogą być to chmury 

lub silny wiatr, albo tylko zbyt niska temperatura jeśli pozostałe opcje nie są zaznaczone. 

Odznaczanie wszystkich opcji spowoduje, że sensor nigdy się nie uaktywni. 
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Typowe konfiguracje połączenia z kartą 

Kopuła 2M 
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Kopuła 3M 
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Kopuła 4M 
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Kopuła 55M 
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Clamshell 3M 
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RollOffRoof 
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Statystyka z czujnika chmur (Cloud Sensor) 

Driver, o ile ma podłączony czujnik chmur, zapisuje dane o stanie nieba i na ich podstawie buduje 

statystyki. Pozwala to na bieżąco śledzić jakość nieba nad obserwatorium. Aby statystyki były 

prawdziwe komputer sterujący kartą w obserwatorium musi być uruchomiony przez 24h na dobę.  

Dodatkowo w katalogu C:\ScopeDome_Driver\AllSky mogą być automatycznie zapisywane 

miniatury zdjęć z kamery AllSky. W tym celu należy zaznaczyć opcję Config>Weather>Archive 

photos in the AllSky subdirectory i oczywiście skonfigurować dostęp do zdjęć z kamery AllSky. 

 
 

Aby przeliczyć wartości należy przycisnąć przycisk Weather>Update Statistic 

Przykład statystyki z Otivar Observatory od października do końca grudnia 2020. 
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Oprogramowanie dodatkowe 

Wraz z driverem w podkatalogu Driver_LS instalowane jest dodatkowe oprogramowanie narzędziowe. W 

menu systemu Windows są instalowane niezbędne skróty do tych programów. 

Arduino_Test_App.exe 

Przy pomocy tego programu można w pełni skonfigurować wszystkie parametry i sposób działania karty 

ScopeDome Arduino. Jest to program narzędziowy przeznaczony dla zaawansowanych użytkowników do 

testów i diagnostyki karty. Nie należy stosować go jako narzędzie do obsługi obserwatorium. Będzie z 

pewnością pomocny dla osób chcących pisać własne oprogramowanie sterujące kartą.  

W zakładce Card należy skonfigurować parametry połączenia z kartą a następnie nacisnąć Save Settings. 

Po ustawieniu parametrów połącznia należy nacisnąć przycisk Connect. To jedyne miejsce w programie, 

które pozwala na zmianę adresu IP, MAC i hasła dostępu do karty. Jeśli używają Państwo kilku kart 

ScopeDome w jednej sieci, to każda z nich musi mieć inny adres IP i inny adres MAC. Domyślny adres IP 

zapisywany do konfiguracji karty to 192.168.1.120 

Naciśnięcie przycisku Get Status spowoduje jednorazowe odczytanie aktualnego stanu karty. 

Przycisk Start powoduje cykliczne (w odstępach zadanych w polu Card Status Reading Interval) 

przesyłanie do karty komendy wybranej w polu Command. 

W zakładce Status można odczytać aktualny stan karty.  

Zakładka Status Txt wyświetla odpowiedź z karty w bardziej czytelny sposób w rozbiciu na sekcje. 

Zakładka Thermometers służy do konfiguracji pracy termometrów i termostatów karty. 

Zakładka Emergency Shutter Close pozwala na zaawansowana konfigurację warunków awaryjnego 

zamykania klap kopuły. 

 

Zmiana adresu IP i MAC karty 

Nowy adres IP lub MAC należy podać po polu Card>Ip address a następnie przycisnąć guzik Save 

Settings. 

 

Włączanie wybranych termometrów 

 

Przy pomocy tych opcji możemy włączyć lub wyłączyć wszystkie lub tylko wybrane termometry na 

karcie. Opcja Board pozwala na wybór karty, którą chcemy programować (Dome lub Shutter). 
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Opcje Master Preset i Slave Preset służą do odtworzenia typowych dla drivera ScopeDome 

ustawień karty. 

Włączanie wybranych termostatów 

 
Przy pomocy tych opcji możemy włączyć lub wyłączyć wszystkie lub tylko wybrane termostaty na 

karcie. Opcja Board pozwala na wybór karty, którą chcemy programować (Dome lub Shutter). 

Opcje Master Preset i Slave Preset służą do odtworzenia typowych dla drivera ScopeDome 

ustawień karty. Opcja Clear All wyłącza wszystkie termostaty na wybranej karcie. 

Termostat na podstawie temperatury, ciśnienia lub wilgotności odczytywanej z wybranego 

termometru może włączać lub wyłączać wybrany przekaźnik w zależności od tego czy została 

osiągnięta zadana temperatura (Set On C). Mówiąc inaczej umożliwia on ogrzewanie np. silnika 

lub lustra teleskopu do zadanej temperatury, oczywiście o ile do wybranego przekaźnika została 

podłączona grzałka. 

Ciekawą funkcją jest możliwość włączania ogrzewania w zależności od wartości innego 

termometru – pozwala to np. na ogrzewanie luster teleskopu o 2 stopnie powyżej temperatury 

otoczenia. 

 

 

Uwaga: Naciśnięcie przycisku „Send Config to card” w driwerze ScopeDome spowoduje 

skasowanie wszystkich zmian z tego programu poza adresem IP karty. 
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ScopeDome_Test_And_Config.exe 

 

Przy pomocy tego programu można:  

• Przeprowadzić losowy test obrotów i otwierania kopuły 

• Skonfigurować kartę w sytuacji gdy driver karty po zmianach wprowadzonych przez 

użytkownika zawiesza się 

Losowy test działania kopuły 

Aby uruchomić test należy: 

1. Przycisnąć przycisk ASCOM>Connect 

2. Wpisać zakres kątów obrotów Demo Parameters>GoTo Range From / To 

3. Następnie zaznaczyć opcję Demo/Test Mode 

 

Awaryjne uruchomienie okna Config 

Po uruchomieniu programu należy przycisnąć przycisk ASCOM>Config 


